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Balancing Checking Account in QuickBooks

1. Print DIAL and Catholic Foundation Statements for the month you are balancing.

2. Add the interest directly to the DIAL account register thereby allowing you to verify the balance with the
statement immediately. Add the earnings to the Foundation account register thereby allowing you to verify the
balance with the statement immediately.

3. Review your bank statement. Look at the “other debits” section on the bank statement. Any monthly fees or
debits that were charged to the account need to be entered into the check register. Go to the check register and
add the fees or debits. Fees and debits to be added include Paylocity Payroll, Bankcard Merch Fees (01-44002),
and PAYA online fees (other 01-44000). Also review for any credits and add them to your check register.

4. In QuickBooks Click Reconcile

BAMKIMNG

Reconcile

5. The statement date should populate with the correct date.

6. Verify that your beginning balance matches your bank statement beginning balance. If it does not match, you
need to resolve why it doesn't match before you begin to reconciliation.

7. Add ending balance from bank statement.

8. Add service charge amount and date from bank statement.

9. |If the account earns interest, enter the interest amount and date.

10. Check off all the deposits from the bank statement including journal entries, voids, and any SO transactions.
Make sure when checking off journal entries made when voiding checks you are doing it both on the deposit and
check side.

11. Investigate any deposits that were not checked off in QuickBooks. The only time that you should have
outstanding deposits is if the deposit is dated at the end of the month and is truly outstanding. Any other
deposits need to be resolved as to why they are outstanding and corrected before you complete your
reconciliation.

12. Mark off all debits and checks that have cleared. Once this is done, the difference in the lower right corner
should be 0.00 (NOTE: Your numbers will be different than what is in the picture.)

Senvice Charge -450.34
Interest Earned 0.00
Ending Balance G5,268.61
Cleared Balance G5,268.61
Difference 0.00

13. If the difference is 0.00, click Reconcile Now.

14. A message will pop up that says “Congratulations your account is in balance”. Select Reconciliation Report,
highlight “Both”, and click Display.

15. Print and save both reports once as a PDF and put it in the appropriate folder in ReCur360 and print a hard copy
for your records.

16. Next run and print “Last Month’s Checks” and “Last Month’s Deposits” and save as a PDF into the appropriate
folder in ReCur360 and print a hard copy for your records.

a. Goto Reports > Memorized Reports = Last Month’s Checks or Last Month’s Deposits.
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17. Run your Dept 50 Reconciliation Report before the end of the month to verify that everything that was deposited
has been remitted to the Diocese. Save the PDF into the appropriate folder in ReCur360 and print a copy.
a. Goto Reports 2 Memorized Reports = Dept 50 Reconciliation = Print = Save as PDF 2>

Cash Summary

Completing the Cash Summary

1. The cash summary in Excel can be found on the Documents and Forms section of the Diocesan website under
Accounting/Payroll 2 Accounting Forms — Cash Summary & Journal Entries.

2. Prepare the cash summary report — go to the prior month report tab in ReCur360 and copy and paste your excel
cash summary into the next month. Make the ending balance the beginning balance. Change the month to the
month and year just balanced. Update total deposits and total checks from the reports printed. The cash
balance (end of current month) should equal the register balance on the Reconciliation Summary Report and
your register balance in QuickBooks. All three of these balances have to match before submitting your date. If it
does not, see if you voided any old checks (dated before the month you are reconciling) and record them on the
worksheet if journal entries were not created when the check was voided. (See below if the Cash Summary does
not balance.)

3. Once everything is balanced run the Diocesan Transaction Report.

4. Go to Reports > Memorized Reports = Diocesan Transaction Report Make sure the dates are correct (the
month just reconciled) = go to print 2 select file, then comma delimited file, print, enter file name (example:
75 Parish Diocesan Transaction Report MM.YYYY).

5. Once all the reports are saved, email CDRaccounting@rockforddiocese.org to let them know that the monthly
reports are available in ReCur360. Make sure you state which month — for example...the April data is saved.

If the Cash Summary ending balance does not balance to the QuickBooks check register
and Reconciliation report.

1. There was most likely a check voided. If you know what happened, go ahead and list the check in the “Voided
Checks” section.
2. There are some reports you can run to find your discrepancies:
a. Voided/Deleted transaction detail
i. In QuickBooks, go to Reports, = Accountant & Taxes, = Voided/ Deleted Transaction Detail.

Banking JEEH) Window Intuit Enterprise Suite  Help.

Memorized Reports »
Scheguled Reports »
VENDC  Commented Reports COMPANY
Cash Flow Hub
=
Company Snapshot =
Chart of
Advanced Repartin,
P u np\ Rg t A
rocess Muttiple Reports ‘
QuickBooks Desktop Statement Writer '
Compine Reports from Multiple Companies liems & Order
Senvices Checks
Company&Financial . [@E ==
pany & Financial | » @
CUSTON s ers & Receivables »

Intercompany  Calendar

Sal Transactions

a
Jobs, Time & Mileage
Vendors & Payables » BANKING
Employees & Payroll _
Banking » &)

Budgets & Farecasts o Ti e
List y G
Industry Specific »

Contributed Reports

Custom Reports »

Audit Trail

Closing Date Exception Report
Transaction History Customer Credit Card Audit Trail
Transaction Journal

Voided/Deleted Transactions Summary

ii. This report should show you all transactions that have been voided or deleted in the time range
you select.
b. Audit Trail
i. In QuickBooks, go to Reports, 2 Accountant & Taxes, = Audit Trail.
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Banking Window Intuit Enterprise Suite  Help
Report Center

Wemorized Reports
Scheguled Reports
vEnpc  Commented Reports
Cash Flow Hub
Company Snapshot
Advanced Reporting
Process Multiple Reports
QuickBooks Desktop Statement Writer
Compine Reports from Multiple Companies

Company & Einancial
CUSTON  Customers & Receivables
sales
| Jobs, Time & Wileage
ACC Vendors & Payables
Credt Employees & Payroll
Banking

Accountant & Taxes

Budgets & Forecasts
List
Industry Specific

Contributed Reports
Custom Reports

»
b
3
»
»
b
»
B

»
b
»
»
»

o
Chart of
Accounts

=
ltems & Order

Senices Checks

&
Intercompany Calendar
Transactions

BANKING

@ &

Adjusted Trial Balance

Trial Balance

General Ledger

Transaction Detail by Account
Adjusting Journal Entries
Journal

gt Iral

ii. If you suspect a transaction amount has been changed, and you have an idea of when it was
changed, but can’t remember which transaction it was, you can run this report for those dates,
and it will tell you all that was done.

c. Rerun Prior Months Reconciliation

i. In QuickBooks, go to Reports = Banking—> Previous Reconciliation = Click on detail, click on

transactions cleared plus any changes made to those transactions since the reconciliation, then

click on display.

yees Banking wmdww Intuit Enterprise Suite Help

Report Center
Memorized Reports
Scheduled Reports
Commented Reports
Cash Flow Hub
Company Snapshot
@ Advanced Reporting
Process Multiple Reports
QuickBooks Desktop Statement Writer
Compine Reports from Multiple Companies

Enter Bills

Company & Einancial
Customers & Receivables
Sales
Jobs, Time & Mileage
¥endors & Payables
Employees & Payroll
Banking
Accountant & Taxes
Budgets & Forecasts
— List
Industry Specific

Create

Invoices Contributed Reports

Custom Reports

Deposit Detail

Missing Checks v

Reconciliation Discrepancy

et @
Payments

1.

s Reconciliation Report

(Report is displayed as a PDF file)

—— —
Check Detail 07/31i2025

Account Type of Report
00-10100 Checking -... = o Summary
@ Detall
Staterment Ending Date 7 Both
oz L
11/30/2025 ' In this report, include
10/31/2025 ~ Transactions cleared atthe time of reconciliation
09/30i2025

Cancel

ii. Compare this reconciliation to the one you printed at the time you did your original reconciliation
and find your differences.
iii. If you still cannot find the discrepancy, call one of the Accounting staff or email your question to
CDRaccounting@rockforddiocese.org for assistance.
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Month End Checklist to Accounting

Remember that QuickBooks is date sensitive.

DIAL and Catholic Foundation Entries:
[1 Enter DIAL interest and Catholic Foundation earnings.

71 Do the statement balances match the QuickBooks balances?
1 Have you entered release from restriction entries for any Foundation withdrawals?

Reconcile Bank Statement in QuickBooks
[l Make sure all entries have been put into QuickBooks before you start the bank reconciliation.

Voiding checks:

[J Is the check in the current month? If so, just void the check (no reversing transactions need to be done)
71 s the check in a prior month? If so

U
U

Verify register balance ties to cash summary and bank rec for month.

Void the check in the check register (not on check image) and allow QuickBooks to make the
reversing entries. If QuickBooks does not give you the option to create reversing entries, you will
have to make them yourself.

Check the dates on the reversing entries: there should be 3 transactions per void:

The original transaction should be voided and "0"

The replacement transaction with the same date as the original transaction but putting the dollar
amount back in (to get the register balance back to the correct value)

The credit appearing in the month the voids were made. Make sure voids are done in the same
month you are reconciling. If not, change the dates on the reversing journal entry to the month
end date of the month you are reconciling i.e. voids on 12/4 change to 11/30 if you are
reconciling November.

1 Does your cash summary match the check register balance in QuickBooks and the register balance on
your reconciliation report?

Have you uploaded the following to the ReCur 360 monthly folder (or email):
| Cash summary (Excel)
| QuickBooks detail and summary reconciliation report for each checking account (i.e. Operating, School
Account etc.) (PDF formats)

(0 I B ) A

Diocesan Transaction report (CSV format)

Last month’s checks and last month’s deposits (PDF formats)

Parishes: Department 50 report (PDF formats)

High Schools: Outstanding tuition report (make sure to use end of current month data to be processed)
Please email CDRaccounting@rockforddiocese.org when everything is in the ReCur360 folder
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Sending Monthly Diocesan Report to Accounting/Data Processing:

1. In QuickBooks, under the Report Menu, select Memorized Reports and open your monthly Diocesan Transaction
Report:

Window Help

Eeport Center
Memuorized Reports
Company Snapshot

Process Multinle Benonts

Memarized Report List

Diocesan Transaction Report #

2. Verify you have the appropriate dates in the report (it should automatically give you last month’s data).

3. Under the File Menu, select “Print Report” (Ctrl+P) and the Print Reports screen will appear. You also have the
option to click on the Print button on the ribbon above the report (circled below).

4. Select Print to “File” and choose “Comma delimited file”

Eile Edit Vie Lists Favorites Company Customers Vendors Employees Banking Reports Window Help

ction Report for Parish #024 2016

Customize Report Share Template Memorize -majl ¥ | Excel v Show Header Refresh

Home _Qates Last Month = From 03/01/2016

Type < Date o Hum e« Name * Account @ Amount =
Calendar Mar 16

Bl To 03/31/2016 EA Total By Total only ~ SortBy Date

= Snapshots Print

Customers

Vendors

Settings

Margins

) Print to:
Employees  Printer: = Options Cancel
| Online Banking ® File: Comma delimited file > Help
Pos Mote: To install additional printers or to change port
i assignments, use the Windows Control Panel. Preview
PAGE RANGE:
@ Al
) Pages:
From: To:

5. Select the Print button and you will be asked to provide a file name
6. Select Save and save to the monthly folder in ReCur360
7. Send an email to CDRAccounting@rockforddiocese.org to let them know the data is ready to be processed.
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3-year Budget Reports - Preparing your Budget

1.

Noukw

9.

Ready to start putting your budget together? Request a 3-year budget worksheet (with previous 3 years of fiscal
year end data) from CDRaccounting@rockforddiocese.org.

The budget document in Excel will contain worksheets for every department your parish/school/agency has
along with an “overview” tab to show you the total net budget of all departments.

Looking at St. David department 1 parish example below, you’ll see the following columns:

Previous fiscal years (circled in green)

Previous 3 yr average

Current period actual (in this case, actuals for the month ending 12/31/2025)

Estimated 6/30/2026

a. This calculates the year-to-date actual column (X) divided by the % of year completed column AD (in this
case 50%) to estimate what could be the year end value.

b. This only works for those items that have steady income or steady expenses each month. For example,
bank interest, DIAL interest, salary and benefits (excluding substitutes or temp positions). Sunday
collections will give you a rough estimation, but look at prior year data for monthly trends.

For all other accounts, look at prior year trends, specific projects you are planning, etc. to fill out the 6/30/2027
budget number.

ks St. David
‘ﬁ Budget Worksheet Iwi Previous Three Years)
001 - Parish — —_
Freviows 3
TR W ¥r. Average

S0.00%
5/30,/2027 Total

Previous Fiscal Years
ETIDE Budget

i

INCOME

Collections
20100 Sunday Envelopes 520,504.35 50023428 2053086 44106133 525,200.00 Use estimated nr
sl Children’s Envelopes 3651.00 1 100 20000 204.00 Use estimated nr
30200 Sunday Offertory 33,311.50 243580 2487181 23520.00 z Use estimated nr
20400 Easter 16,901.78 - - 25,000.00 Apr26
20500 Christrnas 35,902.00 23,000.00 46 000,00 45,000.00 Decxmibar/lan
30550 Haly Days 257825 4 DET 00 6,426.31 228258 458515 5,000.00
20700 Stole Fees 2,300.00 2055.00 2,555.00 2.T46.00 545200 2.500.00
Total Colledions 563,389 21 39501075 616,363.31 26109514 32219029 6.26,824.00 466,070.00
Rewenues
21700 Interest & Dividends 9965 26,568 3385 5349 21.08 oD Use: estimated nr
T2 DIAL Interes 51500 18035 385.50 /ATH 231.54 50.00 Use estimated nr
21800 Donations 8.49361 2B BETET 20,551.13 22EITAT 48,035.81 35.020.00 Laok at prior year trends
31800 DA Refund 20,522.00 24 15T 85 18,536.00 21,104.85 11464.00 22528100 18,000.00 Lok at prior ye
32100 Rent [ncome 300.00 300.00 300.00 300.00 150.00 30000 300.00 Laaovk ait e e
22500 Miscellaneous Income 30.00 - - 2867 100.00 20000 - Lack at prior year trends
Total Revenues 4001026 3334283 39,905 88 44 48632 60,003 22 120,006 44 33.704.00 200
Total Income 60539947 64855338  636.269.19 63674075 321.088.37 64219673 680.528.00 466.572.00

Once you have filled out all the budget numbers in the last column (6/30/2027 Total budget) and your budget has
been reviewed by the pastor / Finance Council or other governing body, you are ready to put your budget into
QuickBooks.

10. Please note that July financials cannot be processed until the accounting office has received the new fiscal year

Accounting-How-To-Guide
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Setting up the Budget Report and Sending to the Accounting Office

Setting up Budget
1. Select the menu option Company-->Planning & Budgeting-->Set Up Budgets.

lle Edit View Lists Favorites Customers Vendors Employees Banking Reports Window Help

Home Page i ’
2 Y z j  Company Snapshat ces BankFeeds = Quickbooks Docs
Home P g Calendar
ome Page nsights
o Documants ,
Lead Center VENDORS
My Company
SetUp Users and Passwords 3

Customer Credit Card Protection.
Set Closing Date
Bulk Enter Business Details...

Planning & Budgeting ¥  SetUp Budgets

To Do List Cash Flow Projector
Reminders I
Alerts Manager

Chart of Accounts Clri+A CUSTOMERS

Make General Journal Entries..

Manage Currency > E

Enter Vehicle Mileage Accept
Credit Cards

Prepare Letters with Envelopes 3

Export Your Company File to QuickBooks Online

% Upgrade your QuickBooks %

Estimates wrean Recei
Invoices

2. Select “Create a New Budget” making
sure to select the appropriate fiscal year
(l.e. 2026-27). Click Next.

Create New Budget x
of

Create a New Budget

Begin by specifying the year and type for the new budget.

o060 |H
2026-27 =

Choose the budget type

3. No addltlonal criteria: @ Profit and Loss (reflects all activity for the year)

() Balance Sheet (reflects ending balance)

Back m Finish Cancel

Create New Budget

c.o“‘""'n

= Additional Profit and Loss Budget Criteria
ofice ——

© Customer.Job
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4. Create a budget from scratch, then click Create New Budget
Finish

Choose how you want to create a budget

@ (Create budget from scratch.]

This option lets you manually enter amounts for each account that you wantto
track.
7 Create budget from previous year's actual data.
This option automatically enters the monthly totals from last year for each
account in this budget.

5. A new spreadsheet appears for you to enter the budget. You’ll see you cannot enter anything in the annual total
column.

Budget

FY2026-27 - Profit & Loss by Account X

Dept 01 Income

01-30100 Sunday Envelopes § 0.00 0.00 0.00 0.00
01-30200 Sunday Offertory 0.00 0.00 0.00 0.00
01-30300 Other Senvices 0.00 0.00 0.00 0.00
01-30400 Easter 0.00 0.00 0.00 0.00
01-30450 Thanksgiving 0.00 0.00 0.00 0.00
01-30500 Christmas 0.00 0.00 0.00 0.00
01-30550 Holy Days 0.00 0.00 0.00 0.00

6. There are a few options to enter data
a. Foraccounts such as salary and benefits, divide the total amount by 12, enter 1/12% in the July column

and click on “copy across” in the bottom left corner. If the annual total is off by a few pennies, adjust the
July amount up or down so the annual amount is correct. For example, 12,000/12 = 1,000. Enter 1,000
in the July column. Click on “copy across” in the lower left-hand corner of the screen, to get a total of
12,000 for the year.

b. Forthose accounts that are only a few times a year, put the total into the appropriate month (i.e.
Christmas Offertory might be November/December/January).

01- 30450 TRankagring 250000 .00 000 000 000 2.000.00 S00.00 000
01-30500 Craisimas 2495500 0,00 [eX ] Q00 D.on 90504 23,005 00 104500

Tip: For accounts that you may record income to each month during the year, but the amount may not be the
same each month, the following reports are available:

For Sunday Envelopes or Sunday Offertory, you can look in QuickBooks at the total for each month for the
prior year as a basis for the monthly budget number. To obtain the monthly totals, do a quick report in
QuickBooks — see below for instructions on how to do a Quick Report.
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For Schools, the FACTS Remittance Projection Report will assist you with the monthly tuition and fee
total, based on the tuition contracts.

Save (you can save from time to time to not lose your work). DO NOT click on “clear” button as you will
lose the entire spreadsheet.

7. Proof your work. Review bottom line to make sure your approved budget total matches your QuickBooks budget
overview report. If you need to make changes, go back into the same budget spreadsheet, make your
corrections, save and run budget overview report again to verify everything matches.

Tip: If you would like to set up a budget report by department, see “Creating a Dept 50 Report” in this guide to
create a report for each department at your parish.

8. The next step is Creating the QuickBooks budget summary report to confirm your net gain/loss for the year: Click
on Reports-->Budgets-->Budget Overview.

File Edil Wew Lisls Favorbes Comgany Cusfomers Mendors Emplogees Banking SSERTEIEN Window Help Spedal Offers

Frocess Mulliphs Reports

Company & Enancial
Customers & Recelvables

@

Enzer Billz

A untan & Taxes *
List b Buogedvs. Achual
Profit & Loss Budget Pedormance

Bucgetus Aduat Sraph

Contribuled Reparts
Custom Repors ¢ Craats Sales

Receipts
a

Transaction Histary ands
Transaclion Journal

9. Select the proper year -Profit & Loss by Account-->Next

Budget Report x

o
s

ofee S

a®

This report summarizes your budgeted account balances.

Selectthe budgetto use when generating the budget report:

FY2025-26 - Profit & Loss byAccount -

Cancel
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10. Account by Month-->Next--> Finish (you'll be able to change to total only when viewing the budget)

Back

Select a report layout for the budget report:

Account by Month -

Example:
Jan  Feb  Mar  Apr
Sales Income
iz Income m
Rert Expense NN OO0 OO oo

mnm
o

S o G e, P o

“ : i C ance‘

11. Select Finish to view the report.

Back

Budget Report x

Click FINISH to create the report.

Accounting-How-To-Guide

Page 12



12. To proof the total net income/loss, select the “Show Columns section and change from “Month” to “Total Only”

and make sure dates are the next fiscal year.

pates T - From 07012025 M To |0B/30/2026

Report Basis: @ Acoual (@) Cash Show Filters.

Wyt By Default - Zoom 1

B4 FM 5t. David
s Profit & Loss Budget Overview
Accrual Basis July 2025 through June 2026
Aug 36 Sep 25 Oct 25
~ Income
* Dept 0 Income
01-30100 Sunday Envelopes. 55,500.00 57,500.00 57,500.00
0130200 Sunday Offertary 26T 251667 291657

oo o LA

1-30300 Other Services

B = &
intut Enderprise Suite  Help

Refresh

= Zoom 100% ~

St. David
Profit & Loss Budget Overview

July 2025 through June 2026

Jul 7S - Jun 7
~ Income
™ Dept 01 Income

0130000 Sanday Ervelopes
130200 Snday Ofteriony
0130000 Other Services
0130400 Easter
0130450 Thanksgeving
013500 Christmas
01-30550 Mol Days
0130700 Savie fees

0131701 Bank interest
~ 0131702 DUAL imterest
139702 DAL biag
139702 AL Savings
Total 01-31702 DIAL Interest
04-31500 Donations

Tip: To exclude zero balance accounts select Customize Report-->Fonts & Numbers-->Except zero amounts.

13. Print the Profit & Loss Budget Overview by selecting Print-->Report-->select printer-->Print

Customize Report Comment on Report Share Template Memorize Print ¥ E-mail » Excel w Hide Header  Collapse Rows Refresh
Dates  This Fiscal Year ~ From 071012025 B To 0630202 Repot T ~ sortsy Default - Zoom 100% +
Report with grid lines
Report Basis: @ Accrual () Cash Show Filters Save As POF
5evi- Pt St. David
Seuzy Profit & Loss Budget Overview
Accrual Basis July 2025 through June 2026
Jul *35 - Jun 26
Total Dept 22 Expense 3922512

¥ Dept 25 Expense
¥ 25-32025 Special Programs - Exp

14. If you still need to make changes, edit the budget, save, and view the Profit & Loss Budget Overview again until

you are finished.
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Sending Budget to the Accounting Office

1. When you have successfully completed entering your budget in QuickBooks, the next step isto runa

summary report to confirm your net gain/loss for the year.
In QuickBooks, go to Reports=»Budgets=»Budget Overview

Eile Edit View Lists Favorites Company Customers Vendors Employees Banking §ill-LliEM Window Help Special Offers

Report Center

Memorized Reparts »
My Shortcuts. Company Snapshot

Process Multiple Reports

Home

M Home
Company & Financial

»
Customers & Receivables 3

@ Sales N
Entergills  J0bs, Time & Mileage b
Vendors & Payables »
3

»

fl

Ei calendar

R

Pay Bills

Banking
Accountant & Taxes

E Employees List »  Budgetvs. Actual

Profit & Loss Budget Performance
= L

i Online Banking Contributed Reports
= it Budget vs. Actual Graph
Custom Reports 3 Create Sales

Receipts
2t

Transaction History ards
Transaction Journal

M Reports

(@ Order Checks

2. Select the FY2026-27-Profit & Loss by Account=>»Next

Budget Report x
- 8

This report summarizes your budgeted account balances.

Select the budget to use when generating the budget report:

FY2025-26 - Profit & Loss by Account -

Back m Finish Cancel

Accounting-How-To-Guide
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3. Account by Month=»Next=» Finish

Budget Rep

Select a report layout for the budget report:
Account by Month -
Example:
Jan Feb Mar  Apr
Sales Income OO ONm OO0 O0m
Mlisc Income 00N 000 OO0 Oom
Fent Expense OO0 OONI OO0 OOm
AL Gl g, g oot
Back HNext | Finish Cancel
First save as a csv file: . N .
1a Report Share Ie*nr ate Mamorize ( Print )E.mall T % * Hide Header = Collapse Refresh
il
H i i ustom * From O7/M71Z016 E To 068/2017 @& Columnzs Month Sort By
1. You will still be in the Budget
Overview report screen in
Jul 16 e Aug 16 L3
QuickBooks. Make sure that 01304
. 150
the dates are for the entire o
fiscal year. Go to the File oo senghs | Msrgin
“" H 2
Menu, select “Print Report :::‘:;n Pridt o: “
(Ctrl+P) and the Print Reports 07 rinte: . Ontions... Cancel
03 P -
screen will appear. You also 031 il Comma delimited file B Help
. . M Mote: To Install additionzl printers or to change port
have the Optlon to click on the M assignments, use the Windows Contral Panal. Preview
Print button on the ribbon B PAGE RANGE:
above the report (circled). 3: & 4l
. o~ F
Once the Print Report box o e _
o1 Fram: To:
appears click on File and "
.. [}
change to Comma Delimited R
File like you do when you save e
your Monthly Diocesan Total O
Transaction Report DERT 03 |
0332
—
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b. Another window will open and you will be asked to provide a file name.
Type in budget and your location number i.e. Budget-XXX 2026-2027.
Make sure you remember the file location. The file type will be *.csv

File: name: | Budget-XXX 2026-2027 1 [ save |

Save as type: ICnmma Separated Value (*.csv) M ﬂ]

c. Selectthe Save button. Make sure you are saving it in the July folder in ReCur360.

Next save the report in a printable format:

URCH - QuickBooks Pro 2013

2. With the Budget Overview report open on the screen in QuickBooks, change —

the Columns option from Month to “Total Only”: _
view

3. Select “Print” and select “Save as PDF”. Name the file Budget Overview-XXX Hide Header | Collapse | | Refres
2026-2027 (the XXX = Parish, School or Columns E]
——— .
Entity number). Save the file in the July folder CHURCH B
in ReCur360. t Overvie P
1e 2017 ek
Two week
Four week
Half month
Maonth
Quarter
Year

Company Customers Vendors Employees Banking Reports Window Help

Balance Sheet Budget Overview

Insi} Customize Report Comment on Report Share Template | Memorize Print * | E-majl v | Excel v Hide Header | Collapse Rows Refresh

Dates  Custom « | From 07/01/2017 [ To 0630/201 Report ITotal only ~ SortBy Default -
Save As PDF

Report Basis: () Accrual @® Cash Show Filters

Send an email to CDRaccounting@rockforddiocese.org letting the Accounting Office know that your budget has been
saved in your July folder in ReCur360.
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Payroll
New Employee Submission

Please double-check all new employee paperwork, making sure all information, especially the social security number, is
legible, complete, and accurate. If you want a Supervisor assigned to the new employee fill in that section on the form.
Encourage direct deposit. All live checks will be mailed directly from Paylocity to the employee’s home. Make sure you
have obtained the appropriate approval from the Chancery Office before the new employee starts their first day. No one
should be working prior to that approval being received from the Chancery per the email sent by Ryan Blackney on

2/3/2026.

Check your payroll

Before sending your payroll for submission, please double-check your payroll to make sure the checks are correct. Verify the
payroll periods. Make sure you have created the appropriate batches.

Batches

Manage Totals

EMPLOYEES CHECKS
2 2

[ ] Batch Name ¢ Checks

|\_L SMH 2.13
|\_f SMS 2.13 2

Accounting-How-To-Guide

Type

SM Hourly

SM Salary

/ /

Begin Date

01/23/2026

02/01/2026

/ /

End Date

02/07/2026

02/15/2026

4+ Create Batch

Status Actions

1- 2 of 2 items

Page 17



Run and review your Pre-Process Payroll Register

Checks

9 Employees

9 Checks

@ Direct deposit 0 Paper C

(Refresh C) (@ Reports V>

Last calculated 2/8/20

Reports

Select Report

o Pre-process Payroll Register

() Time-off Requests Report

Selected Batch

\‘ All Batches

sShow Memo Codes

D ()
v

Compare it to your timesheets or the Master Timecard Summary Report in Time and Labor. Make sure the hours are
correct and have not been doubled or tripled. Verify all salaried employees appear. Make sure all deductions are being

taken especially dependent insurance if someone has just added it.

Timeeard Summary - No Salary Work

Company: J05T68

As of: D/8/2026 11:13:19 AM

Sort By: 1 - Last Name

Grand Totals Reg 0T1 0112 Ttl Paid Tt Unpd

108.00 0.00 0.00 108.00 10.50
Totals by Pay Type Reg oTl1 o012 Ttl Paid Tt Unpd
Work 100.00 0.00 0.00 100.00 0.00
Unit-Musician-80 2.00 0.00 0.00 5.00 0.00
Lunch 0.00 0.00 0.00 0.00 10.50

Accounting-How-To-Guide
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Pre-Process Payroll Register sample.

x
e

n

(15

ly

a3

i
ly

12

i
ly

Code Eaming Huours Rate Amount  Code Tax Stalus Taxable Amount  Cosle Deeduction Amount
REG Reg BHATOD 29.70 257421 HTwW Federal Income 5-0 257421 27724 4ROTH  Roth 403b 12497
403ER 4038 1545 MED Medicare 257421 3733 STEW Steward 20.90
ERMED  ER Medical 505.000 85 0ASDI 257421 159,60
FEES 4.000 1L lllinois SITW 2.574.21 127.42
PENG LayPension .00 154.45
ucz 2.00 5148
Totals 66700 2574.11 Totals 601.59 Totals 12387
Cosdie Eaming Howrs Rate Amounl Code Tax Slalus Taxable Amount Code Dreduction Amounl
REG Reg S0, 000 23.00 69000 FITW Federal Income M-0.00 LX) 5000
FEES 400 MED Medicare L] 10.01
PEN3 LayPension 3.00 20700 855 OASDI GO0 4278
ucz 2.0 13800 1L linois SITW M-0 [LE ) 59.16
I'ntals 30,0000 690.00 Totals 16195 Totals 0.00
Code Eaming Hours Rate Amount  Code Tax Stalus Taxable Amount  Coxde Deeduction Amount
REG Reg H6. 6T 26.03 225589 HFITW Federal Income M-0.00 235589 14142 4ROTH  Roth 403b 13535
403ER 4038 20300 MED Medicare 225589 3271
ERMED  ER Medical 505.000 85 0ASDI 225589 13987
FEES 4000 1L Ilinois SITW 235589 111.67
PENS LayPension 5.00 112.7%
ucz 2.00 45.12
Totals Bo.6T00 115589 Totals 41567 Totals 13535
Code Earming Hours Rate Amount Code Tax Stals Taxable Amount  Code Deeduction Amount
REG Reg 12,0000 15.50 186,000 FITW Federal Income 5-0.00 186,00
FEES 400 MED Medicare 18600 270
ucz 2.00 372 88 OASDI 18600 11.53

1L Ilinois SITW 18600 9.21
I'ntals 12.0000 186.00 Totals 2344 Totals .00
Cosdie Eaming Howrs Rate Amounl Code Tax Slalus Taxable Amount Code Dreduction Amounl
FEES 400 FITW Federal Income M-0.00 320000 3200
MUSD MUSD 40000 B0 3200000 MED Medicare 320000 464
ucz 2.00 640 55 OASDI 320000 19.54

1L lllinois SITW 320,00 15.84
Totals 40000 320,00 Totals 7232 Totals .00

Type
Tax Freg

Chk Date
Met
Dir Dep
Chk

Type

Tax Freq

Chk Date
Net
Dir Dep
Chk

Type

Tax Freq

Chk Date
Nel
Dir Dep
Chk

Type

Tax Freg
Chk Diate
Met

Dir Dep
Chk

Type

Tax Freg
Chk Date
Nel

Dir Dep
Chk

Regular
(5) Senu-
Monthly
2/13/2026
1,848.75
1,848.75
0.00

Regular
(5) Semn-
Moathly
20132026
52805
52805
.00

Regular
(5] Semu-
Monthly
2/13/2026
1,654 87
1,694.87
.00

Regular
(5) Semi-
Moathly
2/13/2026
162.56
162.56
0.00

Regular
(5) Senu-
Maonthly
2132026
247.68
24768
.00

If an error is found, please correct it and run a new Pre-Process Payroll Register to review and save before sending your

email to CDRpayroll@rockforddiocese.org to let us know payroll is ready to be processed. Please note anything

extraordinary that affects the payroll in your email to assist the reviewer.
If an error is found after submission, please notify us immediately so we can get it corrected. We have a very limited
window of opportunity to correct a payroll once it has been submitted to Paylocity.

Once payroll is submitted to Paylocity by the Accounting Office you will need to run a few reports to use to record the
payroll in QuickBooks and for the Pastor or Parochial Administrator to sign off on. The Pastor or Parochial Administrator

should sign both the Check Register and the Payroll Summary which you will find instructions on running below.

Following are the reports you need to run to enter payroll in QuickBooks:

00 GL Report

In HR & Payroll click on Reports & Analytics>Reports=> GL Report. This is the journal entry you will use to enter your
payroll in QuickBooks. Pick which payroll you want to run the report for under the Process Date Range. Click on Export
and then Run.

Accounting-How-To-Guide
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{ 00 GL Report

Filters

Description
GL Custom Report

~~ Payroll Filters

Timeframe (required)
O Most Recent Pay Period
O current Month

O Current Quarter

O Prior Quarter

~~

From

® Process Date Range

© Pprior Month © Quarter 1 01/30/2026 - 2026013001 v
O Current Year to Date O Quarter 2 To
O Pprior Year to Date © Quarter 3 01/30/2026 - 2026013001 v
O Quarter 4
Once the report is ready, Download it.
|GL Account Number GL Account Description PCTY CC1 Department Description Debit Credit
000-10100 Checking - Operating $5,730.64
000-10100 Checking - Operating $765.41
000-10100 Checking - Operating $2,128.96
1001-40800 Secretary & Bookkeeper Parish $676.77
1001-40900 Adminstration Parish $2 574.21
1001-41400 Salaries Parish $186.26
1001-41550 FICA Tax Expense Parish $262.95
1001-41630 Unemployment Compensation Parish $68.75
1001-41900 Diocesan Pension Trust Parish $188.29
1001-41905 Employer Match - 403(b) Parish $21.54
001-42101 Diocesan Accounting & Data Processing  Parish $9.20
_ElElS-dElEiElEl Adminstration Religious Education $1.257.00
003-41550 FICA Tax Expense Religious Education $98.45
1003-41650 Unemployment Compensation Religious Education $25.74
1003-42101 Diocesan Accounting & Data Processing  Religious Education $4.00
01340500 Pastoral Team Ministry Adult Education $1.579.12
1013-41550 FICA Tax Expense Adult Education $120.81
1013-41650 Unemployment Compensation Adult Education $31.58
013-41900 Diocesan Pension Trust Adult Education $78.95
1013-41905 Employer Match - 403(b) Adult Education $14.21
1013-42101 Diocesan Accounting & Data Processing  Adult Education $2.80
1022-40500 Pastoral Team Ministry Music $678.50
1022-40600 COrganist & Choir Music $560.00
1022-41550 FICA Tax Expense Music 404,75
1022-41650 Unemployment Compensation Music $24.77
022-41900 022-41900 Music $20.36
022-42101 Diocesan Accounting & Data Processing Music \ $16.00
| $8,625.01 $8,625.01

Accounting-How-To-Guide
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This is the entry to record your payroll in QuickBooks. You can record it on a check using EFT for the check number.
Create a Vendor “Diocese of Rockford Payroll” to use for the lay employee payrolls and a Vendor “Diocese of Rockford
Priest Payroll” to use for the priest payrolls. Doing it this way all the accounts you need should be recalled on the new
check image and you can simply update the dollar amounts.

Also run under Reports & Analytics 2 Payroll Process = Payroll Summary. You will also run the Check Register and these

are the two reports you need to have the Pastor or Parochial Administrator sign.

Payroll Process 1-100f 10 1tem

Reports Pickup

Process ID 02/02/2026 - 2026020201 Report Class - All - v

Report Name Output Type - All - v

Report Group Standard Reports For Payrun v User - All - v

Generated Date —All - v

®
Name Status Generated Date ¢ Process ID Class Output Type Pages File Size User

\ Check Register Complete 1/30/2026 9:09:07 AM 2026020201 PAYROLL PDF 1 0.1MB System

Invoice Co Complete 1/30/2026 9:09:07 AM 2026020201 INVOICE_PAYROLL PDF 1 0.1MB System

Payroll Register with YTD Complete 1/30/2026 9:09:07 AM 2026020201 PAYROLL PDF 2 0.1MB System
\ Payrall Summary Complete 1/30/2026 9:09:07 AM 2026020201 INVOICE_PAYROLL PDF 1 0.1MB System

401(k) Report Complete 1/30/2026 9:09:07 AM 2026020201 PAYROLL Excel 2007+ (.xIsx) 0.1MB System

Agency Check Summary Report Complete 1/30/2026 9:09:07 AM 2026020201 PAYROLL PDF 6 0.1MB system

Employee Setup - Invalid SSN Complete 1/30/2026 9:09:07 AM 2026020201 HR PDF 1 0.1MB System

FICA Variance Complete 1/30/2026 9:09:07 AM 2026020201 PAYROLL PDF 1 0.1MB System

Labor Distribution Complete 1/30/2026 9:09:07 AM 2026020201 PAYROLL PDF 4 0.1MB System
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Check Date: 01/30/2026
Payroll Summary . 2036013001 Page 1 of 2
TDCCES! £ 3

Pay Period: 017082026 o0 01/22/2026

Payroll Totals
Payroll Checks Check Type Ciomt Mt Chack Dir Dep Ansoumnt Mt A
Regular ] (.02 5730064 5. 730064
Totals L] [(X[31] 5. 73064 5, 730.64 — 5. 73064
Payroll Checks Check Type Agency Type Ciovamal Met Check Dbr Dep Amsoent hoet Ao
Agency Regular 5 (w2 Ta5.41 T65.41
Totals 5 [(X[1] Tas5.41 T6H5.41 —_ Th5.41
Total Net Payroll Liability [(X[31] G405 649005 —_ G.AML05
Tax Liability
FITW and Belated Taxes Tax Id Bt Frequency Wage Cap Wages EE Amouni ER Amount
Federal Income Tax HO-0297147 Semi-Weekly T.541 86 7.541.46 58274
Medicare H0-0297147 Semi-Weekly T.541 86 7.541.46 109,36
Medicare - Employer 2O-0297147 Semi-Weekly T.541.86 T.541.86 104,36
OASDI HO-0297147 Semi-Weekly T.541 86 7.541.46 467.60
OASDI - Employer 2O-0297147 Semi-Weekly T.541 86 T.541. 86 A6T.60
Taotals LIS T0 57696 —s 1. 73666
IL and Related Taxes Tax Id Btz Frequency Wage Cap Wages EE Amouni ER Amount
Hlinois SITW 36-08T9E40 Semi-Weekly T.541 86 7.541.46 39230
Totals 39230 0.0 — 392.30
Taotal Tax Liability 1551040 5T6.9% — LI128.96
Total Payroll Liability 8.625.01 — H625.01
Transfers
Type Dt Source Accommt Amount
Dir Dep 1292026 (MRR4H405* 5. 730.64
Tax 1292026 (OR0R4H405* 212896
Trust Agency 12972026 (OE0E405* T65.41
Totals Transfers B,625.01 — R625.01
Tax Deposits
Begquined Tax Deposas Tax Dz O Amount

The total Transfers should match the total on the 00 GL Report. In this example the amount is $8,625.00
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DIAL Deposits / Withdrawals / Interest

To record deposit to DIAL in QuickBooks:

Jour. Dept. o
- |Account No. Description DEBIT CREDIT
Srce. No.
CK 000 115XX DIAL 100.00
CK 000 10100 CHECKING - OPERATING 100.00

When writing a check from the church checking account to make a deposit to a DIAL account, code the check to the DIAL

account number (for example: 000-11501) you are depositing to.

To record a deposit to DIAL sent directly to the Diocese:

Jout. Dfpt' Account No. Description DEBIT CREDIT
Source | No.

GJ 000 115XX DIAL 100.00

GJ XXX 31800 DONATION INCOME 100.00

If the parish receives a stock donation, the donation will be deposited into the parish DIAL account directly. The parish will

need to make a journal entry in QuickBooks to record the donation.

To record a withdrawal from DIAL in QuickBooks:

Jour. Dept. - ..
. |Account No. Description DEBIT CREDIT
Stce. No.
CR 000 10100 CHECKING - OPERATING 100.00
CR 000 115XX DIAL 100.00

When withdrawing from a DIAL account and depositing to the church checking, code the deposit in the church checking

account to the DIAL account number (for example: 000-11501) where you withdrew the money from.

To record DIAL interest for the month in QuickBooks make a journal entry:

. | Dept.
Jous fp Account No. Description DEBIT CREDIT
Srce. No.
UPD | 000 115XX DIAL 100.00
UPD | XXX 31702 DIAL INTEREST 100.00

XXX = department to record the interest

Cemetery interest must be recorded in department 4.

Make sure your DIAL interest entry is dated the date that the interest was received. For
example, August DIAL interest should be recorded with a journal entry dated 8/31.
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Catholic Foundation Deposits / Withdrawals / Earnings

To record deposit to the Catholic Foundation in QuickBooks:

Jour. | Dept.|  Account Description DEBIT CREDIT
Source No. No.

CK | 000 | 12310 FOUNDATION 100.00

CK | 000 | 10100 CHECKING-OPERATING 100.00

When writing a check from the church checking to make a deposit to a Foundation account, code the check to the
Foundation account number 000-12310.

To Record a donation to the Catholic Foundation sent directly to the Diocese:

Jout. | Dept-| 4 count No. Description DEBIT CREDIT
Source | No.

GI | 000 12310 FOUNDATION 100.00

GI | 999 |318000R31801 | DONATION OR BEQUEST INCOME 100.00

If the parish receives a donation that was sent directly to the Diocese and the donation did not get deposited into parish
checking then a journal entry should be made in QuickBooks to record the deposit to the Foundation. The donation should

be recorded in department 999.

To record withdrawal from the Catholic Foundation in QuickBooks:

Jour. | Dept. | Account Description DEBIT CREDIT
Source | No. No.

CR | 000 10100 CHECKING-OPERATING 100.00

CR | 000 12310 FOUNDATION 100.00

When withdrawing from the Foundation and depositing to the church checking, code the deposit in the church checking
account to the account number 000-12310. In addition, the following entry needs to be made to account number 49319

for release from restriction.

Jour. | Dept.|  Account Description DEBIT CREDIT
Source | No. No.

GI | 999 | 49319 RELEASE FROM RESTRICTION 100.00

Gl | xxx| 49319 RELEASE FROM RESTRICTION 100.00

XXX = department to record the income from the Foundation withdrawal
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To record monthly earnings from the Catholic Foundation in QuickBooks:

Jour. D?pt. Account No. Description DEBIT CREDIT
Source | No.

GI 000 12310 FOUNDATION 100.00

GJ 999 31703 FOUNDATION EARNINGS 100.00

If the monthly earnings from the Catholic Foundation are a loss, the following journal entry

should be made in QuickBooks:

Jour. | Dept-| 4 count No. Description DEBIT CREDIT
Source | No.

GI | 999 31703 FOUNDATION EARNINGS 100.00

GI | 000 12310 FOUNDATION 100.00

Make sure your Foundation earnings entry is dated the month that the earnings were
received. For example, August Foundation earnings should be recorded with a journal entry
dated 8/31.
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Societies

Do not have to be on
the Balance Sheet

Use Parish FEIN

10700 - Society
(examples: Bingo, Booster Club)

10450 - Mass Stipends
10270 - Scrip

If a Parish chooses to have the non-required cash accounts on their balance sheet, they will be updated to the liability
account 000-20XXX and NOT income or expense. When the parish receives money from the society, the deposit is
recorded as xxx- 31300 parish organization income.

Office
Number: Date: __7/1/2025
Jour. Dept. o
Account No. Account Description DEBIT CREDIT
Srce. No.
GJ 000 I0XXX Checking - XXXXXXXX 1,000.00
GJ 000 20XXX XXXXXXXX 1,000.00
To record deposit to Non-required cash account
GJ 000 20XXX XXXXXXXX 500.00
GJ 000 I0XXX Checking - XXXXXXXX 500.00
To record check written from Non-required cash account
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Setting up Subaccounts in QuickBooks
Our reporting system does not recognize subaccounts, it groups all
transactions with the account number together in one account. Because of
this, when you set up a subaccount, the account name MUST have the
account number before the name. See below for a visual.

Select the menu option Lists=> Chart of Accounts or (Ctrl+A)
You should see a listing of your accounts. To make a new
account, click on the downwards arrow next to Account at the
bottom left corner of the screen, then select New Account or (Ctrl+N).
Make sure your main account is set up before you create a new subaccount.
You will be asked to fill out the following:
a. Select Account Type (Income, Expense, Liability, Asset or Bank). Must be
the same as main account.
b. Add Account name (must contain the same
“department -account number” as the main account i.e. 02-32200).
¢. Check the box next to “Subaccount of” and select main account from the

drop down menu.

Add optional information if you wish.
e. Select “Save & Close” when finished.

Sample:

[TTT| AccountType  Income

Account Name  p2-32200 Non-Parish 1st Student

OPTIONAL
Description

Note

Tax-Line Mapping  <Unassigned=

Accountis inactive

# Subaccount of 02-32200 Tuition

How do | choose the right tax line?

Cancel

=/ File Edit View

Helpful Tips:

e Youcan use up to 31 characters in the account name.

Favorites Company Customers Vendg

Chart of Accounts Ctrl+A
ltem List
Fixed Asset ltem List

*

MNew Ctrl+N
*  EditAccount Ctrl+E
+  Delete Account Ctrl+D

Make Account Inactive
-
+  Hierarchical View
+  FlatView
»  Customize Columns...

Import from Excel ... I
Lse Ctrl+L t
Find Transactions in...

Print List... Ctrl+P

Account = Agfiviies * | Rem

e Make sure you use the same department number and account number in the subaccount.

e Do not add any dashes or special characters after the department and account number

e Make sure there is only one space between the number and name of account.
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Setting Up Department 50 Reconciliation
1. In QuickBooks, under the Report Menu, select Custom Reports and
Transaction Details.

2. When the report comes up the “Modify Report” box
appears (if this box does not come up, click on
Customize Report in the upper left-hand corner of
the report). Change the “Dates” box to read “This Fiscal Year” and
uncheck Memo, Class, Clr, Split, and Balance in the “Columns” box
in the lower left-hand corner.

bort: Custom Trans

n Detail Report

Display Filters HeadenFooter Fonts & Numbers
REPORT DATE RANGE
~
Dates This Fiscal Year v From the first day through the last day of the current fiscal year

From 07/01/2019 B To 06/20/2020 [

REPORT BASIS

@ Accrual 0 Cash This setting determines how this report calculates income and expenses
COLUMNS
Search Columns Total by  Total only -
~ <
Default -
¥ Memo Sortoy ey
=) A
Ship Date sortin ® Ascending order £
) Descending order &
Deliv Date Advanced...
Fos Put a check mark nextto each column
¥ thatyou wantto appear in the report. Revert

om Transaction Detail Report

%

ﬂindow Help Special Offers

Report Center
Memorized Reports
Scheduled Reports
Commented Reports
Company Snapshot
Process Multiple Reports

Company & Einancial
Customers & Receivables
Sales

Jobs, Time & Mileage
Vendors & Payables
Employees & Payroll
Banking

Accountant & Taxes
Budgets

List

Contributed Reports
Advanced Reports

Custom Reports 3

Transaction History
Transaction Journal

Modify Report: C

Display Filters Header/Footer Fonts & Numbers

CHOOSE FILTER CURRENT FILTER CHOICES

Search Filters Account FILTER SET TO

[ — Date

All accounts -

This Fiscal Year

Account =
Aging .
Amount

Billing Status

Class

Remove Selected Filter
ACCOUNT FILTER
Choose the types of accounts or a specific account from the
drop-down list Indicate whether or not you want split detail
to appearin the report (Balance Sheet accounts anly).

Tell me more...
Revert

Cancel Help

Search

Account

’_

3

WENDORS

* v v v v v v v v w

CUSTOMERS

Help me choose
Summary

Transaction Detail

elect Account

01-49290 Sale of Equipment
01-49300 Sale of Real Estate
01-49301 Sale of Vehicles
50-48000 International Appl Inc
50-48100 Mission Appeal Income
50-48200 Stewardship Appeal Inc
50-48400 Holy Land Income
50-48500 Mission Coop Income

LN

50-48560 Mational Appeal Inc

Select All Clear All

N
o I

3. Next click on the “Filters” tab at the top. Change the box in the middle from “All Accounts” to “Multiple
Accounts” by clicking on the down arrow at the end of the box. Another box will appear that displays “Select
Account”. Scroll down and put a check mark in front of all the Department 50 accounts, both income and
expense (you will need to scroll down further to find the expense accounts), except account 48680 The Observer —

Receipt. Once all accounts are checked, click OK.
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om Transaction Detail Report

4. Then click on the “Header/Footer” tab at the

“ . ”os Display FEilters Header/Footer Fonts & Mumbers
top and change the “Report Title” line to
. . . SHOW HEADER INFORMATION PAGE LAYOUT
read Department 50 Reconciliation. Click OK. .
# Company Name; | St Mary Church Alignment
. . | Report Title Department 50 Reconciliation
5. Once the report is on your screen click on the —— T E—
down arrow on the “Total By” box and change it to % Date Prepared | 1231101 = B e
“Account List”. You can also modify the dates to % Time Preparad _

whatever time period you want by changing the 4 ReportBasis
”From” and IITO” date bOXeS. +| Print header on pages after first page

SHOW FOOTER INFORMATION

Extra Line
6. Review the report to make sure that the total at the % PageNumoer | Page 1 -
bottom is zero. If there is a balance, review the ¥ ExtraFooter Line
. . + Print footer on first page Revert
income and disbursement accounts for =
; ; ; = Default &
each collection to see which one is not zero. ™ T‘“a'm = SoeYae
Once you identify which collection is off
. . .  — St. Mary Church
look at the details to find the discrepancy Department 50 Reconciliation
and do what is needed to rectify the July 2018 through June 2019
Type Date Num Name Account Amount
p ro b I em. 50-48000 International Appl Inc
» Deposit 03/03/2019 International Appeal 50-42000 Internati... 895.00 4
. Deposit 03M10/2019 International Appeal 50-48000 Internati 8,188.00
7. This should be done monthly, at the end o Deposit 0410812018 international Appeal  50-48000 Internati.. 300.00
Deposit 04/14/2019 International Appeal 50-48000 Internati... 100.00

the month, so if there are any balances
that need to be remitted, they can be
remitted before the end of the month.

Total 50-42000 International Appl Inc 9,493.00
50-48100 Mission Appeal Income

Deposit 10/2142018 Dioc - Mission App... 50-48100 Mission ... 8,783.00
Deposit 1002372018 Dioc - Mission App... 50-48100 Mission ... 2,305.00

101282018 Dioc - Mission App...  50-48100 Mission ... 3,035.00
i 110612018 Dioc - Mission App...  50-48100 Mission ... 1,655.00
8. If you need to add an account to the Deposit MNE2018 Dioc - Mission App . 50-48100 Mission 960 00
. Total 50-48100 MMgion Appeal Income 16,739.00
report, such as for the You Will be My 5048200 stoware g Appeal e
Withess Campmgn, see Step #3 above after Deposit S114/2019 Dioc- DS 50-43200 Steward... 29,476.00
« Deposit Dioc - DS 50-48200 Steward 15,435.00
you have added the accounts “50-48980 — Deposit 061052 Dioc - DS 50-48200 Steward.. 5,600.00
H 27 “ Deposit 06/26/2019 Dioc - DS 50-48200 Steward... 1,055.00
YWBMW — Receipt” and “50-48985 —
Deposit 06/30/2019 Dioc - DS 50-43200 Steward... 200.00
YWBMW - Disbursement”. Any time a Total 50-48200 Stewardship Appeal Inc 51,816.00
. 50-48050 International App Disb
new account is added to the department, Check 03/13/2019 20581  Didg- IntlAppeal 50-43050 Internati... -9,093.00
you WI” need to add them to the custom Check 0416/2019 20703 Dioc - Wl Appeal 50-48050 Internati.. -400.00
Total 50-428050 International App Disb -9,453.00
repo rt. 50-48150 Mission Appeal Disb
Check 11/07/2018 20213 Dioc- Mission AppNy  50-48150 Mission ... -15,779.00
Check 12/05/2018 20290 Dioc - Mission App... :0-48150 Mission ... -950.00
Total 50-48150 Mission Appeal Disb -16,739.00
50-48250 Stewardship Appl Disb
Check 05/14/2019 20764  Dioc-DS 50-48250 Mgward -29,476.00
Check 05/15/2019 20780 Dioc-DS 50-48250 SteviNg... -15,485.00
Check 06/05/2019 20845  Dioc-DS 50-43250 Steward ¥ -5,600.00

Check 08/26/2019 20808 Dioc-DS 50-42250 Steward...
Total 50-48250 Stewardship Appl Disb
TOTAL

-51,516.00
200.00
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Update Diocesan Transaction Report to Include Memo Field

1. Memos appear only in your CSV transaction file you send us; they do not transfer over to the monthly financial

reports.

e Memos can be beneficial to help us to better understand the transaction we may be questioning. If
you receive a reimbursement or a refund, it can be beneficial to note “refund for overpayment” in the

memo field.

¢ [f you do not currently have memos set up in your memorized monthly csv transaction report, please
refer to the following instructions. If you have any questions or need assistance in implementing,
please contact CDRaccounting@rockforddiocese.org.

2. In QuickBooks, under the Report Menu, select Memorized Reports and the Diocesan Transaction Report for

Parish #000.

Window Help Special Offers

Report Center

Memorized Reports
Scheduled Reports
Commented Reports
Company Snapshot
Process Multiple Reports

Company & Financial

Customers & Receivables

Sales

Jabs, Time & Mileage

Vendors & Payables

Employees & Payrall

Banking

Accountant & Taxes

Budgets
List

Contributed Reports
Advanced Reports

3. Click on Customize Report in the upper left-hand corner of the report. When the “Modify Reports” box

Memorized Report List

Accountant

Banking

Company

Customers

Department 50 Reconciliation
DepositDetail01

Diocesan Transaction Report for Parish #000

Disbursements

Disbursements - With Account Detail
Disbursements - Without Account Detail
DisbursementsMNoSplit

Last Months Checks

Last Months Deposits
LastQtrTransDtIByDate01

Movak Center Improvements

Rectory Bathrooms Renovation
Vendors

appears put a check mark in front of Memo in the “Columns” box in the lower left-hand corner. Leave all the

other check marks the way they were.

N

Customize Report

Comment on Report

[EiCI| ast Month * From °
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Maodify Report: Dioces: an: n Report for Parish #000

Display Filters Header/Footer Fonts & Numbers

REPORT DATE RANGE

Dates LastMonth ~  Fromthe first day through the last day of last month
From 10/01/2019 [ To 10312019 [

REPORT BASIS
® Accrual T Cash This setting determines how this report calculates income and expenses.
COLUMNS
Search Columns Total by | Total only .
v
I 1 Default =
Name Account # L Sort by Etau
O A
¥ Memo ‘. sortin ® Ascending order 24
o H
Ship Date Descending order &

Advanced...
Deliv Date Put a check mark next to each column

¥ thatyou wantto appearin the report Revert

4. When the report is on your screen and includes the “Memo” column click on “Memorize”.

Memorize Print |+ E-mail ~ Excel » Hide Header Refresh

3 10/31/2019 B8 Total By Total anly ~ SortBy Default -

St. Mary Church
Diocesan Transaction Report for Parish #062
October 2019
Type Date Num Name Memo Account Class Amount
Oct 19
b Oct19 - 4

5. You will get a box that has the choices of Replace, New, or Cancel. Click on Replace.

Memorize Report

The report you are memorizing is a memorized report. Would you like to replace
the original memarized report or create a new one?

Replace New Cancel
Y ... c

6. When you run your Diocesan Transaction Report for your parish at month-end it will now include the memo
column. The memo is not going to appear on your financial reports. We are going to refer to your memos to
get clarification on transactions that we may be questioning if they are in the right accounts or not. Hopefully
this will reduce the number of questions we have to ask you when we call or email you.

Accounting-How-To-Guide Page 31



Adding Descriptions

= Descriptions can be added for each transaction on the monthly financial statement. This will help anyone
reviewing your monthly financials to have a better understanding of each transaction.
=  For checks, the description is the vendor name written in the “Pay to the order of” section of the check you write.
=  For deposits, the description is the detail you provide in the “Received From” section on the Make Deposit screen.
These names should be added as Other Names.
= For larger deposits (over $25,000 put the name of the Donor in the Received From section for future
reference. For deposits over $25,000, make sure to fill out the Statement of Waiver of Conditions-
Charitable Gift (525,000 and Over) form and email the signed and dated form to Lori Graber at
Igraber@rockforddiocese.org. This form is located at https://www.rockforddiocese.org/documents/ under
Chancery. Include note “waiver sent and date” in memo for Accounting.
=  For General Journal Entries, the description is the detail you provide in the “Name” section. For example, if you are
moving an expense from one department to another or between accounts you could put “Reclass Expense” in the
Name section.

Quick Books Tips and Tricks

How to move a file from the ReCur360 Desktop to the parish computer
Save the file in the Monthly Folder in ReCur360. Open the Monthly Folder = right click and “Copy” the file you
want to move to your desktop. Go to your desktop and paste it where you want it.

How to print a Quick Report

In QuickBooks open your Chart of Accounts. Right click on the account that you want to run the report for and
then click on QuickReport. Another way to run the report is to highlight the account number and then click on
Reports at the bottom and then QuickReport.

. 04-20100 SundagEgaalocs
+01-30200 Sundz o

Refresh Account List
+01-303200 Other
+01-30400 Easte,  Mew
+01-30450 Thank  _orAaccount

Delete Account
=01-30500 Christ
»01-30550 Holy C Make Account Inactive

+01-30700 Stole | - Sromize Columns...

+01-31300 Parist  WWrite Checks

+01-21701 Bank | Make Deposits
°01-31702 DIAL | Enter Credit Card Charges

Transfer Funds
= 01-31702 Dls

= 01-31702 DIs
+01-31800 Donat
+01-31201 Beque Waorking Trial Balance

Make General Journal Entries ...
Reconcile

+01-3 lleti  Aftach
= 01-31900 DS Re QuickReport: 01-20100 Sunday Envelopes
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Reprinting bank reconciliation report

= In QuickBooks, go to Reports = Banking—=> Previous Reconciliation = Click on detail, click on transactions
cleared plus any changes made to those transactions since the reconciliation if you are trying to locate
discrepancies, then click on display. If you just need to rerun the reconciliation report because you forgot

to save it to your Monthly folder in ReCur360 just Display it with the default settings.

pees ilankmgﬂmduw Intuit Enterprise Suite  Help

Report Center

Memorized Reports 3
Scheduled Reports 3
Commented Reports elect Pre: nciliation Report
Cash Flow Hub
Company Snapshot
Advanced Reporting
Process Multiple Reports
QuickBooks Desktop Statement Writer @ Detail
Combine Reports from Multiple Companies

Account Type of Report

&

00-10100 Checking—. = | © Summary
Enter Bills

Statement Ending Date 0 Both
123112025 A

Customers & Receivables l
seles 11/30/2025

Company & Einancial 3
3
v
Jobs, Time & Mileage » 10/31/12025 ~ Transactions cleared at the time of reconciliation
3
v
»

Inthis report, include

Vendors & Payables 0913012025 (Reportis displayed as a PDF file)
Employees & Payroll

. List
Industry Specific

Create eceive
Invoices Contributed Reports 3 Payments |

3
Budgets & Forecasts b Missing Checks
*  Reconciliation Discrepancy
»

Display | Ccancel

Custom Reports 3

Setting up a new vendor in Quick Books
In QuickBooks = click on Vendqr = Vender Center 2 New Vendor

Mnuntant Company Customers Vendors Employees Banking Reports Window  Intu

= -

E MNew Vendor... ¥ E% Mew Transactions * E] Print = Excel = i.—r_, Word - [E
Vmdnen I | W U RSN B

Make sure to enter all vendor information including W-9 information if applicable.

How to make a journal entry

0 QuickBooks = click on Accountant = Make General Journal Entries

SISl Accountant

Company Customers Vendors E

Chart of Accounts Ctrl+a
Fixed Asset ltem List

Batch Enter Transactions...

Batch Deleteffoid Transactions...

Client Data Review 3
Make General Journal Entries...

Send General Journal Entries...

Reconcile

Working Trial Balance

Set Closing Date...

Condense Data...
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The following window will appear

Main Reporis

& P a E g@ Create a Copy y Q @ e =

Find New Save Delete ﬁMemorize Reverse Print Attach Hide Send
= File List GJEs
DATE 02/09/2026 | ENTRY NO. 384 W ADJUSTING ENTRY
ACCOUNT DEBIT CREDIT \EMO

Fill in the account to be debited and credited. Make sure you fill in the memo field with the details of why you
made the journal entry.

Accounting-How-To-Guide Page 34



Using the “find” feature in Quick Books

1. Click Edit=> Find, then transaction type (on right) i.e. Invoice

File ﬂgiew Lists Favorites A Simple [ HEER
| — |

Transaction Type
v

Invaice

Estimate
Sales Receipt
Credit Memo
Bill

Check

Credit Card

To [ ]

Use Register Ctrl+R

Use Calculator Purchase Order

Sales Order
'Find... Cirl+F
Journal

TYPE

2. Then type in any information you are searching for (i.e. Payee, date range, check amount, etc.)

Simple Advanced

Transaction Type

R -

Payee

Date

Mo.

Amount

DATE TYFE

3. For advance search functions, click on “Advanced” tab for deposits searches, for example:
Simple Advanced

CHOOSE FILTER )
Current Choices

FILTER Amount
Account A Any ! FILTER SET TO
Aging l 15.00 to 15.00
Amount 0= @<= O@-- Posting Status | Either
illi EZero Reorder ... [Hide
Billing Status ® From [15.00 To [15.00
Class Help

AT VDS KL IRA
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Customizing a Report in QuickBooks
1. Select Reports — Report Center

Eile Edt Yew Lsis Favomles Company Customers Vendors Employees Banlang Yndow Heip

Search Company o Help P < ¥ Heps ’t:
BhErmc 2 Bpoits

Scheguled Heports

wmemenied Renots

To run a Profit & Loss, select Reports — Company & Financial — Profit & Loss Standard

Window Help
Memonged Reports .
[l Scheguled Reports , Print v E-mail v Excel v HideH

¢ Cemmented Reports Zolumgs  Total only ~ Sort
Company Snapshot

Advanced Reporting

Process Multiple Reports %

QuickBooks Desktop Statement Writer Buildem, Inc.

Combine Reports from Multiple Companes Balﬂnce Sheat
Ao ol Auimasad B8 AN
Proft & Loss Standard

Customers cenables *  Proft & Loss Detail

Sales *  Profit & Loss YTD Companson
Jobs, Time & Mileage * Profit & Loss Prev Year Comparison
Yendors & Payables * Profit & Loss by Job

Employees & Payroll * Proft & Loss by Class

Banling *  Proft & Loss Unclassified

2. Choose the date range you need, select Customize Report

Customize Report Comment on Report Share Template Memorize

Dotes EETEETICSTT - From 05012021 W To 0826/

Banass Daele- at Asse ol M ask - |

3. Then either type in the date range, or use the drop-down menu for a list of pre-set dates ie -“This Fiscal Year-to-

Date”
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Customize Report  Commenton Report  Share Template  Memorize Print v E-mail v Excel v Hide Heade

Dates [T - From 080172021 M To 08262021 M Show Colmps Total only

Re, Basis: ® Accrual Cash Show Filters

Display Firers Header/Footer  Fonts & Numbers
REPORT DATE RANGE
Dates From the first day of the current month through today
From Al A 21 x
Today
REPORT Tpic week
® Aco  This Week-to-date This setting determines how this report calculates income and expenses
This Month
Display This Fiscal Quarter * across the top. Sortby Default -
This Fiscal Quarter-to-date ® Ascending order L
Addsu This Fiscal Year ot o Descending order  £8
P et L N o Year-To-Date % of Row % of Cglumn
This Fiscal Year-to-date i
Yesterday % of Jncome: % of Expense
Last Week
Last Week-to-date Advanced... Revert
Last Month
Last Month-to-date “ Cancel Help
Last Fiscal Quarter

Last Fiscal Quarter-to-date

Total Print 900.00
Last Fiscal Year - Total Advertising 2,500.00
Last Fiscal Year-1o-date nn

4. If you wish to see each month, in the column section, choose to display the columns by month.

Customize Report Comment on Report Share Template Memorize Print v E-mail v Excel v Hide Header Collapse Rows Refresh
Dates [EIAEEICS I - From 01/012021 M To 08262021 M Show Columps Month ~ Sort By Defaut

Report Basis: ® Accrual Cash Show Filters

Buildem, Inc.
= Profit & Loss
Accrual Basis January 1 through August 26, 2021
Jan 21 Feb 21 Mar 21 Apr 11 May 21
“ Ordinary Income/Expense
* Income
Sales of Product » 000 4 £ 879.00 0.00 0.00 576184
Design Income 000 000 32,857 86 000 420103
Construction Income 457800 12,597 45 000 457800 5424 95
Freight Income 205332 000 000 205332 245914
Parts Sales 2371000 0.00 000 2.370.00 613748
Sales Discount 0.00 5,879 00| 000 0.00 0.00
Service Income 66,339 1 259736 000 66,339 323416
Total Income 75,340 63 38568 81 32,857 86 7534063 56,318 60
* Cost ol Goods
Construction Labor 6512712 000 000 653212 6512712
Cost of Sales 459141 1,450 00 2151931 459141 459141
Materials 1,221.06 9822 %822 122106 1,221.06
Total COGS 12,4519 154022 2167753 12,4519 12,4519
Gross Profit 6299 44 37,020 59 11,180 33 62,99 44 4397341
~ Expense
~ Advertising
~ Web
Banner Ads 850 00 50 00 5000 850 00 850 00
Social Media 750 00 50 00 5000 750 00 750 00
Total Web 1,600.00 100.00 100.00 1,600 00 1,600.00
* Primt
Newspapers & Magazines 500 00 6500 6500 500 00 500 00
Brochures = 00 400 00
Yo i Now you see the income and expenses E )
Total Advertising -0 2,500 00
Bask Sarice Charges for each month so far this year s an
Cleaning 260 00 260 00

5. If you want to see fewer details for a specific section, you can click on the arrows to the left of the account name
to collapse the detail into one line. To expand, simply click the arrow again.

6. If you wish to show the change in $ amount of % amount from one period of time to another, click on Previous
Period, $ Change and % Change:
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Sotin ™ Ascending orde ;4
Add subeolamis for D Descendngorder 48
# Prisvous Penod Prewous Year Yea(-To-Date s of Row % of Column
i 3 Change % of Fcome % of Experse
# % Change
Ay arcwd Revert
—

Customize Report Comeeent on Report Share Templyte Mamorize Prig v Eoall » Excel » Hide Hegder Collapze Rows Refrezh
Joses HECTEEEEEEE - 7o 0s012021 B To 08312021 W Show Columps  Total only * Sorl By Defaul
Report Basis: ® Accrual ) Cash Show Filters
Buildem, Inc.
=1 Profit & Loss
Accrual Bask August 2021
Awg Jud 11 § Changs % Chamge
Ordinary Incomet xpeme
I
[ carvitmuncticn b cury L s € 45T iRy 1 2IMa%
Freighit oo 208 % 20535 oo s
Parts Sabes ThEsE X2 Z2¥m0e TEIN X2 ifedt N1
Service Incoemes wWen & 1n N 50.T06 %4

7. When you have created your report and wish to save it, you can click Memorize across the top. Each time you
open this report, you will be able to change the date range as needed.

To run a report with only accounts for a certain department

Click on Customize Report on the bottom ribbon.
Sccountant Company Customers Vendors Employees Banking Repors Window Intuit Enterprise Suite  Help

Customize Report Comment on Report Share Template Memorize Print * | E-mail v Excel v Hide Header | Collapse Rows Refresh

1. Choose your date range.

Madify Report: Profit & Lc

Display Filters Header/Footer Fonts & Numbers

REPORT DATE RANGE

Dates [EENGEINCEY

- From the first day through the last day of last fiscal year

From 07/01/2024 B To 06/30/2025 [

REPORT BASIS

@ Accrual 1 Cagh This setting determines how this report calculates income and expenses
COLUMNS.

Display columns by Total only ~ across the top. Sortby Default -

@® Ascending order E

Sortin - _ ] -

Add subcolumns for Descending order  &¢
Previous Period Previous Year Year-To-Date % of Row % of Column
% of Income % of Expense

Advanced... Revert

2. Under Filters, highlight the Account Filter on left, select Multiple Accounts in drop down in the middle and a list of

account numbers will pop up. Click all of the account numbers you want to show on your report. Click ok. Then
click ok again.
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Modify Report: Profit & Lo

Display Filters Header/Footer Fonts & Mumbers

CHOOSE FILTER CURRENT FILTER CHOICES

Account FILTER SETTO
— Account Multiple accounts...
- “‘dultiple accounts... - _
Pecon : : Date Last Fiscal Year
. ' Include split detail?
Aging % No
Amount T Yes
Billing Status For detail accounts matching
Class N

Remove Selected Filter
ACCOUNT FILTER

Choose the types of accounts or a specific account from the
drop-down list. Indicate whether or not you want split detail
to appear in the report (Balance Sheet accounts only).

Tell me more...
Revert

Search

+ Dept 09 Income

4 09-31100 Socials, Bazaars, etc.
v 09-21100 Octoberfest '
S 09-31300 Parish Org - Income

o 09-31300 Bereavement Ministry
v 09-31300 Creation Care Team
v 09-31300 Divarce

v 09-31300 Domestic Violence
v 09-31300 Funeral Luncheon

Select All Clear All

3. When you have selected all the accounts you wish to have in the report, select “OK.” Now you have a report with
only the accounts you want (useful for all accounts in one department i.e. Home & School, Cemetery, Athletics,
etc.). Here is a sample of Department 9:
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St. David

Profit &

Loss

July 2024 through June 2025

Income
Dept 09 Income
09-31300 Parish Org - Income
09-31300 Funeral Luncheon
09-31300 Respect Life
09-31300 Social Events
Total 09-31300 Parish Org - Income
09-31800 Donations
09-32020 Special Programs-Inc
09-32020 Hesed House
Total 09-32020 Special Programs-Inc
Total Dept 09 Income
Total Income
Gross Profit
Expense

Net Income

4. To change the name of the report, click Customize and click on Header/Footer and re-name the report.

Modify Report: Profit &

Jul*24 - Jun 25

400.00 4
151334
2 690,00
460334

0.00

413.00
413.00
5,016.34
5,016.34
5,016.34
0.00
5,016.34

+| Time Prepared
+| Report Basis

+| Print header on pages after first page

SHOW FOOTER INFORMATION

+| Page Mumber Page 1 -
+| Extra Footer Line

+| Print footer on first page

E:ctra Line

Display Filters Header/Footer Fonts & Mumbers
SHOW HEADER INFORMATION PAGE LAYOUT
¥ Company Mame St. David Alignment
iy Standard -
+ Report Title Profit & Loss Dept#gl ]
+| Subtitle July 2024 through June 2025 Time Company
bate Title

7| Date Prepared 12/31/01 - = Gubtitle

sz

Page

Revert

Cancel Help

5. Click Ok.
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St. David

Profit & Loss Dept #9
July 2024 through June 2025
Jul '24 - Jun 25
Income
Dept 09 Income
09-31300 Parish Org - Income

09-31300 Funeral Luncheon [ 400.00 4

09-31300 Respect Life 1513.34

09-31300 Social Events 2,650.00
Total 09-31300 Parish Org - Income 4603.34
09-31800 Donations 0.00

09-32020 Special Programs-inc

09-32020 Hesed House 413.00

Total 09-32020 Special Programs-Inc 413.00

Total Dept 09 Income 5016.34
Total Income 5,016.34
Gross Profit 5,016.34
Expense 0.00
Net Income 5,016.34

6. After reviewing the data, you can now memorize your report.

Customize Report Comment on Report : Memorize

Miscellaneous
Recording Cemetery Income

Every parish with a cemetery should record Grave Sales to the following accounts:

004-36100 (Sale of Graves) — 80% of the sale is to be recorded to this account
004-36400 (Income Care Receipts) — 20% of the sale or a minimum of $200 is to be recorded to this account.

For example:

If a single grave sells for $1,000 then $800 would be coded to 004-36100 and $200 would be coded to 004-36400. If a
single grave sells for $800 then $600 would be coded to 004-36100 and $200 would be coded to 004-36400.

If a single grave sells for $1,200 then $1,000 would be coded to 004-36100 and $200 would be coded to 004-36400.
The Income Care Receipts should be remitted to your DIAL Income Care account each month. To determine if you have

anything to remit each month you can run a quick report on 004-36100 to see what the amount is to remit. The check
written to DIAL will be coded to 000-11551.
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